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Communications Regulation Information

FCC Declaration of Conformity

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception 
is suspected.

Radio and Television Interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If the interference
stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct the interference
by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops. 

m Move the computer to one side or the other of the television or radio.

m Move the computer farther away from the television or radio.

m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make
certain the computer and the television or radio are on circuits controlled by different circuit breakers or 
fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. 

Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the 
FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 

Responsible party (contact for FCC matters only): Robert Steinfeld, Apple Computer, Inc., 1 Infinite Loop,
Cupertino, CA 95014-2084, 408-974-2618.

Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment regulations. 

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.
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VCCI Class 2 Statement

Notify Your Telephone Company

Some telephone companies require that you notify the local business office when you hook up a modem to their 
lines.

Information You Need in the United States 

The optional internal modem complies with Part 68 of the FCC rules. On the back of this equipment is a label that 
contains, among other information, the FCC registration number and ringer equivalence number (REN). If 
requested, provide this information to your telephone company.

m Ringer equivalence number (REN):  0.8–0.9 The REN is useful to determine the quantity of devices you may 
connect to your telephone lines and still have all those devices ring when your telephone number is called. In 
most, but not all areas, the sum of the RENs of all devices connected to one line should not exceed five (5.0). 
To be certain of the number of devices you may connect to your line, as determined by the REN, you should 
contact your local telephone company to determine the maximum REN for your calling area. 

m Telephone jack type: USOC, RJ-11 An FCC-compliant telephone cord and modular plug are provided with this 
equipment. This equipment is designed to be connected to the telephone network or premises wiring using a 
compatible modular jack that complies with Part 68 rules. See the installation instructions for details.

Telephone Line Problems

If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect the modem to see 
if the problem goes away. If it doesn’t, report the problem either to your local telephone company or to your 
company’s telecommunications people. 

If disconnecting the modem eliminates the problem, the modem itself may need service. See the service and 
support information that came with your Apple product for instructions on how to contact Apple or an Apple-
authorized service provider for assistance. 

If you do not disconnect your modem when it is adversely affecting the telephone line, the telephone company 
has the right to disconnect your service temporarily until you correct the problem. The telephone company will 
notify you as soon as possible. Also, you will be informed of your right to file a complaint with the FCC. 

The telephone company may make changes in its facilities, equipment, operations, or procedures that could 
affect the operation of your equipment. If this happens, the telephone company will provide advance notice in 
order for you to make the necessary modifications to maintain uninterrupted service.

The optional internal modem will not work with party lines, cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange (PBX). 

Telephone Consumer Protection Act 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains in a 
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it 
was sent and an identification of the business or other entity, or individual sending the message and the 
telephone number of the sending machine of such business, entity, or individual.
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Information You Need in Canada 

The Industry Canada (IC) label identifies certified equipment. This certification means that the equipment meets 
certain telecommunications network protective, operational, and safety requirements. The Department does not 
guarantee the equipment will operate to a user’s satisfaction. 

Before installing this equipment, make sure that you are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an acceptable method of connection to install the equipment. In 
some cases, you may extend the company’s internal wiring for single-line individual service by means of a certified
telephone extension cord. Be aware, however, that compliance with these conditions may not prevent 
degradation of service in some situations. 

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated by the 
supplier. Any equipment malfunctions or repairs or alterations that you make to this equipment may cause the 
telecommunications company to request that you disconnect the equipment. 

In Canada, contact Apple at: 7495 Birchmount Road, Markham, Ontario, L3R 5G2, 800-263-3394

Users should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This precaution may 
be particularly important in rural areas.

Informations Destinés aux Utilisateurs Canadiens

L’étiquette d’Industrie Canada identifie un matériel homologué. Cette étiquette certifie que le matériel est 
conforme à certaines normes de protection, d’exploitation et de sécurité des réseaux de télécommunications. Le
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder au réseau de l’entreprise 
locale de télécommunication. Le matériel doit également être installé en suivant une méthode acceptée de 
raccordement. Dans certains cas, le cablage appartenant à l’entreprise utilisé pour un service individuel à ligne 
unique peut être prolongé au moyen d’un dispositif homologué de raccordement (cordon prolongateur 
téléphonique).

L’abonné ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus n’empechent
pas la dégradation du service dans certaines situations. De fait, les entreprises de télécommunication ne 
permettent pas que l’on raccorde un matériel aux prises d’abonné, sauf dans les cas précis prévus par les tarifs 
particuliers de ces entreprises.

Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien autorisé 
désigné par le fournisseur. La compagnie de télécommuncations peut demander à l’utilisateur de débrancher un 
appareil suite à des réparations ou des modifications effectuées par l’utilisateur ou à cause de mauvais 
fonctionnement.

Veuillez contacter le fournisseur suivant pour des informations supplémentaires :

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Apple Canada Customer Assistance Line: 800-263-3394

Warning  Users should not attempt to make such connections themselves, but should contact the appropriate 
electric inspection authority or electrician

m Load number:  0.3 The load number (LN) assigned to each terminal device denotes the percentage of the 
total load to be connected to the telephone loop that is used by the device, to prevent overloading. The 
termination of a loop may consist of any combination of devices, subject only to the requirement that the sum 
of the load numbers of all devices does not exceed 100.

m Telephone jack type: CA-11
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Pour sa propre protection, I’utilisateur doit s’assurer que tous les fils de mise à la terre du secteur, des lignes 
téléphoniques et les canalisations d’eau métalliques, s’il y en a, soient raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions rurales.

Information You Need in the United Kingdom

This terminal equipment is intended for direct connection to the analogue Public Switched Telecommunications
Network and is approved for use within the United Kingdom with the following features:

m Modem facility

m Autocalling facility

m Autoanswer facility

m DTMF signaling

m Operation in the absence of proceed indication or upon detection of proceed indication

This product is in conformity with relevant regulatory standards following the provisions of European Council 
Directives 73/23/EEC (Low Voltage Directive) and 89/336/EEC amended by 92/31/EEC (EMC Directive).

Information You Need in Germany

Diese Modem-Karte ist als Endeinrichtung vorgesehen und muss an ein TAE mit F-Kodierung angeschlossen 
werden.

Diese Endeinrichtung ist in Konformität gemäss Niederspannungsrichtlinie 73 / 23 / EWG sowie EMC-Richtlinien
89 / 336 / EWG und 92 / 31 / EWG.

Information You Need in France

Ce matériel est conforme aux normes applicables de sécurité éléctrique d’après la directive 73 / 23 / CEE et aux 
normes applicables de comptabilité éléctromagnétique d’après la directive 89 / 336 / CEE, modifié par la directive 
92 / 31 / CEE.

Avertissement  L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit avoir recours à un 
service d’inspection des installations électriques ou à un électricien, selon le cas.

m Numéro de charge : 0.3 L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute 
surcharge, le pourcentage de la charge totale qui sera raccordée à un circuit téléphonique bouclé utilisé par ce 
dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de l’ensemble des dispositifs ne dépasse pas 100.

m Type de prise téléphonique : CA-11
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Laser Information

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.

Your computer is a Class 1 laser product. The Class 1 label, located in a user-accessible area, indicates that the 
drive meets minimum safety requirements. A service warning label is located in a service-accessible area. The 
labels on your product may differ slightly from the ones shown here. 

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.

Warning  Making adjustments or performing procedures other than those specified in your equipment’s 
manual may result in hazardous radiation exposure.

Class 1 label Service warning label
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C H A P T E R

1
1 Setting Up

Your Macintosh PowerBook has been designed so that you can set it up quickly and start 
using it right away. If you have never used a PowerBook or are new to Macintosh computers, 
read this chapter for an overview of PowerBook features and instructions on getting started. 

If you are an experienced user, you may already know enough to get started with your new 
PowerBook. Take a moment to look over the information in this manual to find out about the 
new features of your Macintosh PowerBook.

Becoming Familiar With Your Macintosh PowerBook

Your PowerBook is designed to keep you working productively in any location. The 
information in this manual covers setting up, using, and expanding your PowerBook
hardware. With a PowerBook, you have

m easily configurable and expandable hardware.

m Mac OS system software along with software for connecting to the Internet.

m interactive online information and instructions for using the computer.

m a separate manual for troubleshooting, and system software reinstallation.

Hardware at a Glance

The illustrations on the next several pages show the built-in features of your computer,
including the expansion bays, PC Card slots, and the ports for connecting a printer, network, 
and other external equipment.
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Your Computer’s Components and Controls
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Sleep indicator

Blinking green light indicates when the PowerBook is in sleep.

® Power button 

Turns your PowerBook on and off.

Microphone

Record sounds directly to your PowerBook hard disk with this built-in microphone.

¤ Brightness control

Increase or decrease the brightness of your PowerBook display.

Ï Volume control

Increase or decrease the volume of the sound coming from your built-in speakers and 
sound output port using this control.

— Mute button

Turn the sound off and on from the PowerBook external speakers and sound output port.

Trackpad

Move the pointer on the PowerBook display. The trackpad can also be set up so that you 
can double-click and select items directly instead of using the trackpad button.

Right expansion bay with a CD-ROM or DVD-ROM drive module inserted

Dual-function expansion bay that accepts either removable modules (3.5-inch or 5.25-inch 
size) or a PowerBook battery.

Ç Security slot

Protect your PowerBook by connecting a security cable.
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Your Computer’s Ports and Connectors
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Infrared window

Allows you to use infrared (IR) communication to send files to another IR-equipped
computer or connect to a wireless IrDA network. 

g SCSI port (HDI-30) 

Connect up to seven external SCSI devices (such as external hard drives or scanners).

´ Printer/External modem port

Connect to printer, external modem, or LocalTalk network.

™ External monitor port

Connect to any external monitor with a VGA-style connector or to any Macintosh monitor 
using the included adapter.

Æ External TV out port 

Connect to any television, VCR, or other video device that supports S-Video, NTSC, or PAL
formats.

V ADB port

Connect a mouse, external keyboard, or other ADB device.

G Ethernet port (10Base-T)

Connect to a high-speed 10Base-T Ethernet network.

¯ Power adapter port

Connect the power adapter to your PowerBook. When connected, the power adapter 
provides power to your PowerBook and also charges the batteries inside the PowerBook.

PC Card slots

Expand the capabilities of your PowerBook using these two PC Card slots that support 
both PCMCIA and CardBus formats.

W Internal modem port (some models)

Connect a standard phone line directly to the optional internal modem. 

Left expansion bay with a PowerBook battery

Dual-function expansion bay that accepts either 3.5-inch removable modules or a 
PowerBook battery.

√ Sound input port

Connect an external line level microphone or other sound input device.

- Sound output port

Connect external speakers, headphones, or other sound output device.
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Setting Up the Computer

Now that you know some essential details about your PowerBook, you’re ready to set it up 
and begin using it. Setting up your Macintosh PowerBook for the first time is a quick and 
simple process. However, there are a few items that you need to have and things to do before 
you begin using your PowerBook.

Your PowerBook Battery

The battery that came with your PowerBook computer may be already inserted in an 
expansion bay. If not, you should insert it now so that it can be charged.

You can easily tell if the battery is already installed by looking at the left expansion bay. If you 
see an opening for a floppy disk, then the floppy disk drive module is installed and the 
battery is not installed. If you see a small button with four small lights to its right, the battery
is installed.

If Your PowerBook Did Not Come With the Battery Installed

If your PowerBook did not come with the battery inserted in the expansion bay, you should 
insert it in place of the floppy disk drive module in order to charge it. 

To remove the floppy disk drive module and insert the battery, follow these steps: 

1 Place your PowerBook on a hard flat surface.

Important  Before following the setup instructions in this chapter, you may want to read 
“Arranging Your Work Area and Equipment” on page 87 for tips on adjusting your work 
furniture and computer so that you’re comfortable when using the computer.

PowerBook battery

PowerBook battery inserted
in the left expansion bay

Floppy disk drive module
inserted in the left expansion bay
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2 Pull the left expansion bay release lever to partially eject the floppy disk drive module.

3 Slide the floppy disk drive module out of its compartment.

4 Gently slide the battery (with the battery name facing up) into the left expansion bay until 
the edge of the battery is flush with the left side of the PowerBook.

Be sure the battery is completely inserted.

If Your PowerBook Came With the Battery Installed

New PowerBook computers that ship with a battery installed have a shipping label covering 
the battery to protect it from losing its charge completely. You need to remove the label 
before the battery will provide power for the computer.

1 With the display open, peel off the part of the shipping label on the computer’s case, taking 
care not to tear the label.

2 Pull the left expansion bay release lever to partially eject the battery.

3 Slide the battery out of its compartment. 

4 Carefully remove the shipping label from the battery.

Avoid touching the battery’s metal contacts as you peel off the label.

5 Replace the battery.

Wall St. User’s Manual
034-0426-A
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Plugging In the Computer

Plugging in the power adapter recharges the computer’s battery. You should plug in the 
power adapter in case the battery has drained during shipping or storage.

When you are ready to begin, follow these steps: 

1 Plug one end of the power cord into the power adapter and the other end into an outlet or 
power strip.

2 Plug the power adapter plug into the power adapter port (marked with the icon ¯) on the 
back of the computer.

Warning  Use only the power adapter that came with your Macintosh PowerBook
computer. Adapters for other electronic devices (including other Macintosh PowerBook
models and other portable computers) may look similar, but they may damage your 
computer.

If your power adapter came equipped with a three-wire grounding plug—a plug that has a 
third (grounding) pin. This plug will fit only a grounded AC outlet. If you are unable to 
insert the plug into the outlet because the outlet is not grounded, contact a licensed 
electrician to replace the outlet with a properly grounded outlet. Do not defeat the 
purpose of the grounding plug!

Power adapter plug

¯ Power adapter port

Power cord

Power adapter
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Opening the Display

1 Gently pull the display latch to release it.

2 Position the display at a comfortable viewing angle. 

You can adjust the angle of the display at any time by tilting it toward or away from you.
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Turning the Computer On

To turn on the computer for the first time, press the Power button (®) above the keyboard.

You should hear a tone when you turn on the computer. It takes the computer a few 
moments to start up. As the computer starts up, several messages appear on the screen, 
including an application to help you set up the Mac OS. 

Note: Certain system settings (such as sound volume, screen brightness, and AppleTalk
connection) may not be saved the first time you set them if the battery has been completely 
discharged or has been out of the computer for three days or more. You will need to reset 
these system settings the second time you start up the computer.

® Power button
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Problems Turning the Computer On?

Nothing happened when you pressed the Power button.

m The battery may be drained. Make sure that you plugged in the power adapter, and that 
the power adapter is firmly connected to both the computer and a power source. If the 
power adapter is plugged into a power strip, make sure the power strip is plugged in and 
turned on. 

m If the computer doesn’t start up when you press the Power button, hold down the Shift,
Function ( fn), and Control (ctrl) keys and then press the Power button (®). The Sleep 
indicator light glows briefly while the computer goes through a reset process. After the 
power indicator light turns off, wait a few seconds and then press the Power button again 
to start up the computer. Once the battery has charged, you should be able to use the 
Power button normally.

m If the computer still doesn’t turn on, see the troubleshooting manual that came with your 
computer.

There is a slight delay after you press the power button before the computer 
starts up.

m Every time you press the power button, the PowerBook performs a check of the 
computer’s memory, causing a slight delay in startup. The more memory you have 
installed in the PowerBook, the longer the delay.

You see a picture of a disk with a blinking question mark on the screen.

m This icon usually means that the computer can’t find system software on the hard disk or 
any disks attached to the computer. You may need to reinstall system software. See the 
troubleshooting manual that came with your computer.
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Adjusting the Internal Display

Before you begin working with your new PowerBook, you may need to adjust your display so 
that items on the screen are easy to see. Your PowerBook comes with a control (labeled with 
the ¤ icon) that adjusts screen brightness.

m Use the brightness (¤) control to change the brightness of your display. 

If your display is too dark, press and hold the right side of the brightness control (labeled 
with the + icon) until items are easily visible on the screen. If your display is too bright, 
press and hold the left side of the brightness control (labeled with the – icon) until items 
are easily visible on the screen. 

Adjusting the Resolution of the Internal Display

You can increase the size of images on your built-in display by switching from the standard 
resolution to a scaled resolution. To do so, click the Resolution icon in the Control Strip. 
When you switch to a scaled resolution, items on the screen appear larger, making them 
easier to see. 

Note: Scaled resolutions may not appear as sharp as the standard display resolution.

¤ Brightness control

Resolution icon
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Moving Items on the Screen

You use your PowerBook trackpad to move items and select items on the screen. To move 
the arrow pointer on the screen, slide your finger across the trackpad. To select, click, or 
double-click an item on the screen, press the trackpad button.

The trackpad is sensitive to how fast you move your finger. To move the pointer a short 
distance across the screen, move your finger slowly across the trackpad. The faster you move 
your finger, the farther the pointer moves on the screen.

You can find more information on setting up your PowerBook trackpad in the online help, 
available in the Help menu.

Trackpad Trackpad button

Tips for Using the Trackpad

For best results when using the trackpad, keep in mind these tips: 

m Use your index finger (left or right hand). Use only one finger.

m Use only your finger on the trackpad. Do not use a pen or any other object. 

m Keep your finger and the trackpad dry. If the trackpad becomes moist from 
humidity or condensation, gently wipe the trackpad with a clean cloth before you 
use it. 

m Never use any kind of cleaning solutions on your PowerBook trackpad.
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Putting the Computer to Sleep

Sleep is a power conservation feature of Macintosh PowerBook computers that lets you 
quickly wake the computer and bypass the startup process. You can extend the period of 
time your battery will power the computer by putting the PowerBook to sleep when you 
won’t be using it for several minutes or more. The length of time the computer can be left in 
sleep depends on how much charge is left in the battery.

When the computer is in sleep, it has a darkened screen and appears to be off. A small green 
light flashes on the case when the computer is in sleep.

To put the computer to sleep, follow these instructions:

1 Press the Power button (®).

The following dialog box appears.

2 Click the Sleep button.

You can also put your computer to sleep by doing one of the following: 

m closing the display

m choosing Sleep from the Special menu

m clicking the Energy Settings icon in the Control Strip and choosing Sleep Now from the 
menu that appears

3 To wake the computer, press the Power button (®) or any key on the keyboard (except for 
the fn key.)

The screen reappears as it was before the computer went to sleep.

Note: To decrease the time it takes for the computer to wake up from sleep, turn off 
AppleTalk. For more information, see the online help, available in the Help menu.

Warning  Once you put your computer to sleep, listen for the hard disk to stop spinning 
before you move your PowerBook. Moving your computer while the hard disk is spinning 
can damage your computer.

Energy Settings icon
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Problems Working With Computer Programs or the Mac OS

If software difficulties (such as a software error message on your screen) don’t allow you to 
use standard methods of quitting a program or restarting your computer, you can try using 
these special key combinations.

The reset key combination immediately turns off the computer. Then the sleep indicator 
light glows briefly while the computer goes through the reset process. After the sleep 
indicator light turns off, wait a few seconds and then press the Power button again to start up 
the computer.

For more information on solving problems, see the troubleshooting manual that came with 
your computer.

To do this... ...press this key combination

Force a program to quit x-Option-Esc

Force the computer to restart x-Control–Power button

Force the computer to reset Shift-Fn-Control–Power button

Important  Only force the computer to reset if the other two key combinations are 
unsuccessful at solving your problem. When you force a reset, your computer’s default 
(original) settings will be restored. You may need to reconfigure settings for power 
management, memory, trackpad, TCP/IP, and AppleTalk if you reset the computer.
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Turning the Computer Off

Always use one of the following methods to shut down the computer. If you don’t, you risk 
losing any work you haven’t saved. You also risk losing any open documents.

To turn the computer off, follow these instructions:

1 If the computer is in sleep, press the Power button (®) or any key on the keyboard (except 
for the fn key) to wake it.

2 Press the Power button.

The following dialog box appears: 

3 Press the Return key on the keyboard (or click the Shut Down button in the dialog box).

If any applications are still open, a message asks if you want to save your work before the 
computer shuts down.

Note: You can also turn off the computer by choosing Shut Down from the Special menu.

What’s Next

For more information about working with your computer’s hardware, refer to the following 
chapters in this manual: 

To learn more about the basics of your computer’s hardware, including the expansion bays, 
batteries and power, and connecting to a network, go to Chapter 2, “Using Your PowerBook
and Connecting to a Network.”

To learn how to connect additional equipment to your PowerBook, such as printers or 
external monitors, go to Chapter 3, “Connecting Additional Equipment.”

To learn how to install additional memory or remove your hard disk, go to Chapter 4,
“Installing a RAM Expansion Card and Removing Your Hard Disk.”
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2
2 Using Your PowerBook and 

Connecting to a Network
This chapter provides information and instructions on using the built-in features of your 
Macintosh PowerBook such as expansion bays, batteries, and PC Card slots. In addition, this 
chapter describes connecting your PowerBook to a computer network and using your 
internal modem (available on certain configurations only).

The information in this chapter will help you get started using the features of your 
PowerBook. Many of these features, such as networking and infrared communication, require 
that you configure your system software or use specific applications. You can find more 
information in the online help, available in the Help menu.

In this chapter you will find information on using the following items: 

m expansion bays and expansion bay modules

m batteries and power management

m PC Card slots that support PCMCIA and CardBus formats

m infrared communication

m connecting to a local area network

m using your internal modem (available on certain PowerBook configurations)

For information on connecting additional equipment such as printers and external monitors, 
see Chapter 3, “Connecting Additional Equipment.”
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Using the Expansion Bays

Your PowerBook comes with dual-function expansion bays that accept either expansion bay 
modules or PowerBook batteries. Expansion bay modules–such as a floppy disk drive, CD-
ROM drive, or DVD-ROM drive–are removable, which allows you to easily switch or replace 
them with another module.

Dual-function expansion bays give you maximum flexibility in setting up your PowerBook to 
meet your needs. For example, if you are working with your PowerBook at home or in the 
office and you have the power adapter plugged in, you can have a floppy disk drive module 
in one expansion bay and a CD-ROM or DVD-ROM drive module in the other expansion bay.
If you are traveling on a long plane trip, you can have a battery in each expansion bay.

Using Expansion Bay Modules

Expansion bay modules and PowerBook batteries are inserted and removed in the same way.
You can switch expansion bay modules while the PowerBook is turned on, in sleep, or shut 
down. You should change batteries only when the PowerBook is shut down or in sleep 
(unless there is a charged battery in the other expansion bay). For more information on 
PowerBook batteries, see “Power Sources” on page 37.

If you purchase an expansion bay module from an independent supplier, be sure to follow 
the instructions that came with the device. Some modules may have special requirements.

Important  Only use expansion bay modules and batteries specifically designed for this 
PowerBook. Expansion bay modules and batteries from other PowerBook computers are 
not compatible.

Left expansion
bay

Right
expansion bay

Important  Don’t switch modules while the computer is starting up. Also take care not to 
remove a module if a floppy disk, CD-ROM disc, or other media is inserted (even if the 
computer is in sleep). If you remove a module (such as the CD-ROM drive) when a disc is 
inserted, you’ll see a message telling you to reinsert the module.
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Removing an Expansion Bay Module

Before removing an expansion bay module from your PowerBook, you need to make sure 
that it is not in use and that it does not contain a floppy disk, CD, or other media. To remove 
an expansion bay module from your Macintosh PowerBook, follow these steps: 

1 Place your PowerBook on a hard flat surface.

2 Click the Expansion Bay icon in the Control Strip to determine whether the expansion bay 
module is ready to be removed. 

If the Control Strip indicates that the expansion bay module is not removable, quit any 
application programs or files that may be using it. Then do one of the following: 

m Drag the icon of the floppy disk, CD, or other media that is inserted in the module to the 
Trash.

m Click the icon of the floppy disk, CD, or other media that is inserted in the module and 
choose Put Away from the File menu or choose Eject from the Special menu.

m Click the Expansion Bay icon in the Control Strip and choose Make Right Module 
Removable from the menu that appears.

Important  If you are going to remove both expansion bay modules at the same time, 
adjust your PowerBook display so that it is at a 90-degree angle to the computer. If the 
display is adjusted too far back, your PowerBook may tip backward when both expansion 
bays are empty.

90o

Expansion Bay icon

Important  Do not remove an expansion bay module that is in use, or you may lose data. If 
you try to remove the module when it is in use, you’ll see a message telling you to 
reinsert it.
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To be sure that the computer isn’t using the module, wait 5 seconds after quitting programs 
and ejecting a disk before you remove the module.

3 Pull the expansion bay release lever to eject the module.

When the lever is completely extended, the module will be partially out of the expansion bay.

4 Gently slide the expansion bay module out of the computer.

Important  If you see a message telling you to reinsert the module, the module is still in 
use. Reinsert the module and repeat step 2.
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Inserting an Expansion Bay Module

The PowerBook battery and the optional floppy disk drive module can be placed in either 
expansion bay. The CD-ROM or DVD-ROM drive module (because of its larger size) can only 
be put in the right expansion bay.

To insert an expansion bay module, follow these steps: 

1 If the expansion bay that you want to use already has a module in place, remove it as 
described in the previous section.

2 Gently slide the module into the expansion bay until the edge of the module is flush with the 
side of the PowerBook and you hear the module click into place.

Make sure that you insert the module with the label facing up.

Note: The right expansion bay can accept the wide 5.25-inch CD-ROM or DVD-ROM drive 
module or the narrower floppy disk drive module or PowerBook battery. When a narrower
device is in the expansion bay, a small flap covers the empty part of the bay. When the wider 
CD-ROM or DVD-ROM drive module is inserted, the flap folds into the bay.

Insert the module with
the label facing up.
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Using a Disc in the CD-ROM or DVD-ROM Drive

Inserting a Disc

To load a disc in the drive, follow these steps: 

1 Make sure that the CD-ROM or DVD-ROM drive module is inserted into the right expansion 
bay.

2 Start up the PowerBook, if it’s not already on.

3 Press the Open button on the outside of the module to open its tray.

4 Pull the tray all the way open.

Open button

Drive spindle

Drive lens

Important  Do not touch the drive lens. 
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5 Place a disc in the tray, with the label facing up. 

Make sure the disc is lying flat in the tray and is seated firmly on the spindle.

Note: CD-ROM and DVD-ROM drives have small locks on the drive spindle that securely 
hold the disc in place. When inserting a disc over these locks, you may need to apply 
additional pressure. Place the hole in the center of the disc directly over the drive spindle 
and press down until you feel the disc lock into place.

6 Push the tray in to close it.

Keep the tray closed except when loading discs. This prevents dust from getting inside the 
mechanism. Be sure to keep discs free of dust and grease.

Note: When the drive is in use, you may notice some vibration as the disc spins rapidly.
Certain discs can cause the drive to vibrate because they have heavily inked artwork or a label 
that creates an imbalance as the drive spins. Some vibration is not unusual for a high-speed 
CD-ROM or DVD-ROM drive. To minimize vibration from unbalanced discs, do not put labels 
on your discs. In addition, place the computer on a flat, solid surface when using the drive.

Insert the disc,
label side up.
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Ejecting a Disc

Follow these instructions to open the tray and eject a disc from the drive: 

1 Open the tray.

There are several ways to open the tray of your drive.

If a disc icon appears on your screen, do one of the following:

m Select the disc icon on your screen and drag the icon to the Trash.

m Click the disc icon and choose Put Away from the File menu or Eject from the Special 
menu.

m Click the Expansion Bay icon in the Control Strip and choose Make Right Module 
Removable from the pop-up menu that appears.

If no disc icon appears on your screen, do this:

m Press the Open button on your drive.

If you can’t eject a disc, try this method:

m If the standard methods of ejecting a disc do not work (or the computer is shut down), 
you can eject the disc manually. Carefully insert the end of a pen or straightened paper 
clip into the small recessed button next to the eject button, and push firmly until the tray 
disengages.

2 Take the disc out of the tray.

Store your discs in a safe place, away from heat, dust, and moisture.

3 Push the tray in to close it.

To avoid possible damage to the tray or the drive, keep the tray closed when you are not 
using it.

Expansion Bay icon
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Power Sources

Your computer can draw its operating power either from a PowerBook battery in one of the 
expansion bays or from an external power source, using the external power adapter that 
came with your computer.

AC Power

You can run your computer from an electrical outlet by plugging in the external power 
adapter that came with your computer. A battery in an expansion bay will automatically be 
charged whenever the external power adapter is plugged in.

Main Battery

The main lithium ion (LiIon) battery provides power to your computer when it is not 
plugged into an electrical outlet. 

This battery should provide power for 2–3.5 hours of work time (you may get longer work 
time, depending on the Macintosh PowerBook model you have and the battery conservation
features you use). You can find more information about the battery and power conservation
software that came with your PowerBook in the online help, available in the Help menu. 

Note: The LiIon battery is charged whenever the external power adapter is connected. 
However, the adapter will charge the battery more quickly if the computer is shut down or in 
sleep.

Optional Second Battery

You can configure your computer with a battery in each expansion bay. This configuration is 
especially useful when you need to use your PowerBook under battery power for a long 
amount of time, such as on a long plane flight. You can purchase a second battery from an 
Apple-authorized dealer.

Note: When fully charged batteries are installed in both expansion bays, the batteries are 
discharged one at a time. The battery in the left expansion bay is discharged first. When the 
charge in the left battery is depleted, the PowerBook switches to the battery in the right 
expansion bay.

Important  Be sure to use only the external power adapter that came with your computer 
or one made specifically for this PowerBook model.
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Recharging the Battery

To recharge the battery inside the computer, plug in the external power adapter. You may 
also use an external battery charger designed specifically for your Macintosh PowerBook
model (available from other manufacturers).

When the AC adapter is plugged in, the LiIon battery is recharged whether the computer is 
off, on, or in sleep. However, the battery will recharge more quickly if the computer is off or 
in sleep.

Monitoring the Battery Charge

There are four ways you can determine the charge level of your battery:

m Look in the Battery Monitor portion of the Control Strip.

m See low-power messages on your display.

m Look at the battery level icon next to the clock in the menu bar.

m Look at the battery indicator level lights on the battery.

Power adapter plug

¯ Power adapter port

Power cord

Power adapter

Warning  Use only the external power adapter that came with your computer. Adapters 
for other electronic devices (including other portable computers) may look similar, but 
they may damage your computer.

If your power adapter came equipped with a three-wire grounding plug—a plug that has a 
third (grounding) pin—this plug will fit only a grounded AC outlet. If you are unable to 
insert the plug into the outlet because the outlet is not grounded, contact a licensed 
electrician to replace the outlet with a properly grounded outlet. Do not defeat the 
purpose of the grounding plug!
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Using the Battery Level Indicator Lights

You can tell the charge left in your battery by looking at the battery level indicator lights on 
the battery itself. The charge can be checked with the battery inserted or outside the 
PowerBook.

Push the battery level indicator button to activate the battery level indicator 
lights.

The lights show how much charge is left in the battery. A lighted square indicates that the 
battery has power; an unlighted square indicates lack of charge. The indicator lights remain 
lit for a few seconds.

Note: The battery level indicator lights stay on while the battery is being charged by the 
external power adapter. When the battery is fully charged, the lights turn off.

Responding to Low-Power Messages

When the battery runs low, the computer displays a series of low-power messages. The work 
time remaining after you see the first message varies depending on how you are using the 
computer. It’s a good idea to act promptly.

What You Should Do

When you see a low-power message, you should do one of the following: 

m Plug in the external power adapter.

m Save your work and shut down the computer.

m Put the computer to sleep, and quickly replace the depleted battery with a charged one.

What You Should Know

When the first low-power message appears, the screen dims automatically to save power. If 
you continue to work without plugging in the power adapter or changing the battery, the 
computer displays a second low-power message indicating that the computer is about to put 
itself to sleep. Within a few seconds, the computer goes to sleep automatically to protect the 
contents of RAM. All activities are interrupted. It’s a good idea to save your work when you 
see the first of the two low-power messages to make sure you don’t lose information.

Fully charged

3/4 charged

1/2 charged

1/4 charged
Battery level
indicator button

Battery level
indicator lights
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If you continue working until the computer goes to sleep automatically, you can wake it 
again as soon as you plug in the power adapter or replace the battery with a charged battery.

Maximizing Work Time

The amount of work time your PowerBook’s battery can provide before you need to 
recharge depends on the equipment you’re using with your computer and the steps you take
to conserve power while you work.

Battery-saving measures include the following (in order of effectiveness): 

m Make sure that power cycling is turned on.

Your PowerBook reduces the processor power when it is not being used in order to save 
battery power. For instructions on setting up power cycling, see the online help, available 
in the Help menu.

m Set your PowerBook to run in a reduced processor speed mode when performing tasks 
such as word processing that don’t require fast processing speed.

Setting your PowerBook to run in a reduced processor mode will provide additional 
battery savings but may affect system performance. For instructions, see the online help, 
available in the Help menu.

m Remove CD-ROM and DVD-ROM discs when they are not in use.

m Set the hard disk to spin down after a short time interval.

m Set your PowerBook display to turn off (instead of dim) when not in use.

m Reduce screen brightness using the brightness control (¤) on the PowerBook case.

m Set your PowerBook to sleep after inactivity of 5 minutes or less.

m Take advantage of the sleep feature of your PowerBook whenever your work is 
interrupted. You just need to close the display to put the computer in sleep.

You can find more information on the power conservation software and battery
conservation tips in the online help, available in the Help menu.

Note: If your PowerBook came with an internal modem, it does not support the Energy
Saver feature “Wake up when the modem detects a ring.”

Important  Recharge a depleted battery as soon as possible. Leaving a depleted battery in 
the computer for a length of time (especially in a hot location, such as the trunk of a car) 
may damage the battery so that it can’t be recharged. If this happens, you need to replace 
the battery.
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Removing or Replacing the Battery

PowerBook batteries are removed in the same way that expansion bay modules are. To
remove or replace the battery, follow these steps: 

1 Place your PowerBook on a hard, flat surface.

2 Save your work and then shut down the computer, put it to sleep, or plug in the power 
adapter.

3 Pull the expansion bay release lever to eject the PowerBook battery.

4 Gently slide the battery out of the expansion bay.

5 Push the charged battery into the expansion bay to lock it into place. 

It’s a good idea to plug in the power adapter in case the battery is not fully charged.

Important  Batteries contain chemicals, some of which may be harmful to the 
environment. Please dispose of used batteries according to your local environmental 
guidelines.

Lithium-ion
(Li-ion)
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Using PC Cards

PC Cards (also known as PCMCIA or CardBus cards) are about the size of a thick credit card 
and have a 68-pin connector at one end. They come in many varieties, such as fax/modem 
cards, mass-storage cards, Ethernet connection cards, zoomed video cards, and wireless 
communication cards. You can use PC Cards to expand your Macintosh PowerBook’s
capabilities.

Your Macintosh PowerBook has two PC Card slots. You can insert a card into either slot, or 
(depending on the cards you’re using) you can use both slots simultaneously.

There are three types of PC Cards. The different types refer to the thickness of the card. A 
Type I card is 3.3 millimeters (mm) thick, a Type II card is 5 mm thick, and a Type III card is 
10.5 mm thick.

You can place a Type I or Type II card in either slot. You can place a Type III card only in the 
lower slot. When a Type III card is installed, you cannot use the upper slot. You may find it 
useful to get in the habit of always using the lower slot first to make sure the card is properly 
inserted.

A special type of PC Card supports “zoomed video,” which can display full-motion video in a 
window on the computer’s screen.

Note: Zoomed video cards must be placed in the lower PC Card slot.

This section describes how to insert and eject PC Cards and how to use PC Card modems. 
You can find more information on using PC Cards in the online help, available in the Help 
menu.

Warning  Make sure only to use cards that are compatible with your Macintosh 
PowerBook. If you use an incompatible card, you may damage the card or your 
PowerBook. If you are not sure whether a PC Card is compatible with your PowerBook,
contact the PC Card’s manufacturer.
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Inserting a PC Card

To insert a card, do this: 

m Insert the card, label up, into the slot. Make sure the card is level.

You’ll feel some resistance as you slide the card in. When the card is firmly seated, you will 
feel it click into place.

An icon for the PC Card appears on the desktop.

You are now ready to use the card.

Consult the card’s documentation for details of its use.

A Type I or Type II PC Card
can be inserted in either
the upper or lower slot.

A Type III PC Card must
be inserted in the lower slot.
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Ejecting a PC Card

You can eject a PC Card when your computer is on or off. You cannot eject a PC Card when 
the computer is in sleep. 

To eject a PC Card when the computer is on, follow these steps: 

1 If the computer is in sleep, press the Power button (®) to wake it.

2 Make sure that nothing is blocking the card slot.

3 Click the PC Card’s icon to select it.

4 Drag the card’s icon to the Trash to eject it from the card slot.

The card will partially eject from the card slot.

5 Pull the card out of the slot.

If you want to use the card again immediately, pull it out about an inch more, wait 10 
seconds, and then push it back in. 

You can also eject a PC Card by doing the following: 

m Click the card’s icon to select it. Then choose Put Away from the File menu or Eject from 
the Special menu. After the card is ejected, pull it out of the slot. (If a dimmed icon of the 
card remains on the desktop, drag it to the Trash.)

m Press the eject button for the slot containing the PC Card you want to eject. If the card is 
not in use, it will usually be ejected.

Warning  Do not force a PC Card out of the slot. Doing so may damage your computer 
or PC Card.

Important  Try to use the eject buttons only when the computer is turned off. Many PC 
Cards won’t eject this way if the computer is on.

Press to eject
upper PC card

Press to eject
lower PC card
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If You Can’t Eject a Card

If you are unable to eject a card, follow these steps: 

1 Shut down the PowerBook.

2 Straighten one end of a paper clip.

3 Insert the end of the straightened paper clip into the hole next to the slot that contains the 
card, and press gently but firmly until the card is ejected.

4 Pull the card out of the slot.

Using a Zoomed Video PC Card

The lower PC Card slot has circuitry for handling video signals, called “zoomed video.” You
can purchase PC Cards to which you can provide a video signal from a video camera, VCR, or 
other such device. The zoomed video card can only be used in the lower slot.

With a zoomed video card installed, the PowerBook can display video on the computer’s
screen or on an external monitor while performing other tasks at the same time. 

If you purchase a zoomed video PC Card, be sure it has software that works with your 
PowerBook.

If you can’t eject a card, insert
the end of a straightened paper
clip into the hole next to the slot.
This hole is for the upper slot. 
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Using a PC Card Modem

If your PowerBook does not come with a built-in modem, you can purchase a PC Card 
modem. For information on using your built-in modem, see the section “Using Your
PowerBook’s Optional Internal Modem” on page 51. If you are using a PC Card modem, 
make sure you do the following: 

1 Install the communications software you want to use and any software that came with your 
modem.

2 Insert the PC Card modem.

A PC Card modem icon appears on the desktop.

3 Plug your modem into a working phone line.

4 To set up and connect, follow the instructions that came with your modem and 
communications software.

If you are having problems setting up your PC Card modem, try the following: 

m Make sure to choose your PC Card modem in your communications software.

Some modem files come with your PowerBook. If your PC Card modem is not listed, 
check the software that came with your modem. If you find the file for your modem, drag 
it to the Modem Scripts folder inside the Extensions folder (which is in the System 
Folder).

If you can’t find the file for your modem, try using the modem file for a different model 
from the same manufacturer. If this doesn’t help, you may be able to get the correct
modem file from your PC Card modem’s manufacturer.

m Make sure to choose the port for your PC Card modem.

The port shows the modem name or type, rather than the name of the PC Card slot. 
Some programs use a virtual port, the Data Port, to allow fax and data applications to 
share the modem. See the instructions that came with your modem and communications 
software to determine the specific setup procedure.

You must reselect the port if you remove the modem and later put it in the other slot.
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Using the Infrared File Transfer Capability

Your PowerBook comes with built-in infrared (IR) communication features that let you send 
and receive data without wires. 

With IR communications, you can exchange files with another PowerBook or with a desktop 
Macintosh using an external IR module. You can also use IR to make a wireless connection to 
a network by means of a specialized local area network (LAN) access device that is 
compatible with the Infrared Data Association (IrDA) Standard specifications.

To transfer files, your computer and the other IR device must be within range of each other 
with their IR windows facing. The range depends on the devices and the method of 
communication.

Note: For best results, place the IR windows directly facing each other. If the angle between 
the windows is greater than 10 degrees, an IR connection may not be possible. 

IR-equipped PowerBook computers must be within 3 feet of each other to exchange files
using the IRTalk transfer protocol (at 230 kilobits per second). Your computer must be within 
3 feet of a LAN access device or another IrDA PowerBook to make a connection (at a 
communications rate of up to 4 megabits per second).

For information on setting up your software for IR communication, see the online help, 
available in the Help menu.

IR window
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Connecting to a Local Area Network

Your computer has built-in hardware allowing you to connect to the following types of 
networks:

m LocalTalk: To connect to a Local Talk network, you plug a LocalTalk cable to the printer/
external modem port (´) on the back of the PowerBook.

m Ethernet: To connect to a high-speed Ethernet network, you plug an Ethernet cable into 
the Ethernet port (G) on the back of the PowerBook.

Once your computer is connected to a network, see the online help, available in the Help 
menu, for information about printing to a network printer, accessing information on file
servers, and sharing files on your computer with other users. Ask your network administrator 
for information about network services such as Internet access and electronic mail.

Connecting to a LocalTalk Network

To connect your Macintosh PowerBook to a LocalTalk network, you need LocalTalk cables 
and a LocalTalk adapter (available from your Apple-authorized dealer). If a network 
administrator is responsible for network maintenance and upkeep at your location, ask for 
help connecting your computer to the network.

To connect your Macintosh to a LocalTalk network, do the following: 

1 Open the cover on the computer’s back panel to access the printer/external modem port 
(labeled with the ´ icon). 

2 Attach the LocalTalk adapter to the printer/external modem port.

´ Printer/External
               modem port
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3 Attach a network cable between the LocalTalk adapter connected to your computer and a 
LocalTalk adapter on your existing network.

4 If you are using a LocalTalk adapter with RJ-11 (telephone) connectors, connect a terminator
to the unused RJ-11 connector on the LocalTalk adapter. A LocalTalk adapter with DIN-8 
connectors doesn’t require an external terminator. (For more information on terminators,
see the instructions that came with the Apple LocalTalk RJ-11 Connector Kit.)

See “Configuring Your Network Connection” on page 50 for information on configuring your 
LocalTalk connection.
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Connecting to a 10Base-T Ethernet Network

The built-in Ethernet capabilities of your Macintosh PowerBook allow you to connect to a 
standard (10 Mbit) Ethernet network. If a network administrator is responsible for network 
maintenance and upkeep at your location, ask for help connecting your computer to the 
network.

To connect your Macintosh PowerBook to an Ethernet network, use the Ethernet cable that 
came with your computer. (The connector on the cable looks like a standard telephone 
connector, but it is wider.)

To connect your PowerBook to an Ethernet network: 

1 Open the cover on the computer’s back panel to access your Ethernet connector (labeled 
with a G icon). 

2 Locate a modular Ethernet cable and connect one end of the cable to the network.

3 Connect the free end of the Ethernet cable to the Ethernet port.

4 Set up your PowerBook software to use Ethernet communication.

Configuring Your Network Connection

After you physically connect your computer to a network, you need to configure the software
for your network connection using AppleTalk and/or TCP/IP. You can find more information
in the online help, available in the Help menu.
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Using Your PowerBook’s Optional Internal Modem

Some models of the Macintosh PowerBook come with an internal modem card installed in 
the communications slot inside your computer. To see if a modem is installed, open the 
modem panel on the left side of the computer. If you see a connector for a phone line, then 
the modem is installed.

Setting Up Your Modem’s Connections

To use the internal modem, you need the following:

m the single-line telephone cord supplied with your PowerBook, which has a standard RJ-11 
phone connector at each end

m an analog telephone line (the type found in most homes) with a modular jack 

You can find more information on setting up your modem communication software to 
work with your PowerBook internal modem in the online help, available in the Help 
menu.

Connecting the Telephone Line to the Modem

Follow these steps to connect the telephone line to the modem.

1 Open the cover on the left side of the computer to expose the modem telephone line 
connector.

2 Locate the telephone cord that came with your PowerBook.

Phone line
connector

Modem panel

Important  Use the telephone cord that came with your computer or an equivalent 
single-line telephone cord. Other types of telephone cords may not work correctly with the 
modem.
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3 Plug one end of the telephone cord into the internal modem port on your PowerBook.

4 Plug the other end of the telephone cord into your telephone wall socket.

Once the telephone line is connected, you are ready to begin using the modem.

Warning  The telephone line must be an analog line—the type used in residences. Do 
not connect a digital telephone line to the modem, because the wrong type of line could 
damage the modem.

Important  When you have established a modem connection with another computer or an 
online service, do not put the computer to sleep. Doing so will disconnect the modem.
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What Modems Do

A modem allows your computer to communicate over telephone lines by converting 
information from the digital format used by the computer to the analog format used by most 
telephone systems. It dials the telephone number, establishes a connection with another 
modem, and controls the flow of data so that communication takes place with optimal speed 
and accuracy.

To exchange data over a telephone line, your modem and the remote modem must establish 
a connection and agree on how data will be transmitted in these ways: 

m Connection speed: Initially, your modem tries to connect at its fastest speed. If the 
remote modem cannot connect at this speed, your modem tries to use the next highest 
speed. The two modems continue this fallback process until they find the highest speed 
supported by both.

There are several circumstances that may prevent your modem from communicating at its 
fastest speed. For example, the telephone number you use to connect to your ISP may 
not support the fastest speed of your modem.

m Error control: Error control ensures data accuracy. Your modem and the remote modem 
must agree on an error control method. Your modem will try to use one of the methods it 
supports. If the remote modem doesn’t support any of these methods, error control isn’t
used. Modems can still communicate reliably without error control.

m Data compression: Compression increases the speed of data transmission by up to four 
times. Your modem will try to use one of the data compression methods it supports. If 
the remote modem doesn’t support any of these methods, data compression isn’t used. 
Modems can still communicate reliably without data compression.

Your modem is set up to make the best possible connection with other modems 
automatically. You do not need to do anything.

Software for Your Modem

Your Macintosh PowerBook comes with modem software, including programs to connect to 
the Internet and to send and receive faxes. Some of this software is already installed for you. 
Other software, such as your fax software, needs to be installed from a separate CD that came 
with your computer. For instructions on using these programs, see their electronic manuals 
on your computer’s hard disk or on the CD that came with your computer.

Important  The actual speed of data transmission can vary with line conditions. Because 
Federal Communications Commission (FCC) rules restrict the power output of modems 
used by service providers, transmission speeds are limited to 53 Kbps (53,000 bits per 
second) in the United States. You can obtain speeds of 53 Kbps on downloads from an 
Internet service provider (ISP) that uses K56flex modems.
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Choosing the Port Setting

You must specify the modem port in each communications program before you can connect 
to another computer by modem. 

The following example shows how to specify the modem port in America Online (AOL) 
software.

1 Open AOL (on your hard disk).

2 If you are new to America Online, click Continue in the dialog box that appears. If you have 
an AOL account already, click Upgrade.

3 Follow the instructions on the screen to set up an AOL account or to upgrade your current
AOL account.

When you finish setting up your AOL account, the AOL Welcome window appears.

4 Click Setup in the Welcome window.

The Location window opens.

5 In the Port pop-up menu, choose Internal Modem.

6 In the Type pop-up menu, choose PowerBook/GV Internal 56.

7 In the Speed pop-up menu, choose 57600 bps.

Always choose the highest speed available. This is the speed at which the computer 
communicates with the modem.

8 Click Save.

Now the AOL software is ready to use with your modem.
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Modem Tips and Troubleshooting

If you have problems using your modem, try the following suggestions: 

m Make sure the telephone cord is connected properly. Unplug the telephone cord and 
reconnect it to ensure a good connection. You may also want to try a different telephone 
cord.

Note: Your PowerBook internal modem does not support the Energy Saver feature 
“Wake up when the modem detects a ring.”

m Make sure the telephone line you are using is working.

Connect a telephone to the line. You should hear a dial tone when you lift the receiver.

Listen for noise on the line. If the telephone line quality is poor, your modem may have 
trouble maintaining a connection or sending and receiving faxes. If you have a problem 
with the line quality, try connecting again. If the problem persists, you may need to 
contact your telephone service provider.

Important  The PowerBook internal modem will not work with party lines, cannot be 
connected to a coin-operated telephone, and may not work with a private branch exchange 
(PBX).
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3
3 Connecting Additional Equipment

The illustration below shows where equipment should be connected to your Macintosh 
PowerBook. In most cases, you should refer to the documentation that came with your 
equipment for instructions on connecting. The safest course is always to shut down your 
Macintosh PowerBook before you connect any cable other than the power adapter. However,
you can connect external devices to the sound input port (√), sound output port (-),
printer/external modem port (´), Apple Desktop Bus port (V), and Ethernet port (G)
while the computer is on.

Information is provided in this chapter for connecting the following devices: 

m printers and external modems

m SCSI devices

m external monitors and video display devices

m sound input and output devices

m mouse, keyboard, or other ADB devices

m security equipment to protect your PowerBook

External TV
out port 

™ External
         monitor port

Internal modem
port (some models)Infrared

- Sound output port

¯ Power adapter port V Apple Desktop Bus
     (ADB) port

√ Sound input port

´ Printer/external
               modem port

g SCSI port
      (HDI-30)

Ethernet port
(10Base-T)

G

Æ W

-
√

¯

V ´ G
g

Æ
™
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Connecting a Printer

Your PowerBook has a printer/external modem port, which you use to connect a printer.

The printer/external modem port can accept either a direct connection (to a printer such as 
a StyleWriter) or a LocalTalk network connection (to a printer such as a LaserWriter). See the 
documentation that came with your printer for specific information about the type of 
connection it requires. Your computer comes with most Apple printer software (called 
“printer drivers”) already installed. If you are using a printer from a manufacturer other than 
Apple, you may need to install a printer driver.

You use the Chooser to tell the computer which port you used to connect your printer. You
can find more information on selecting a printer in the online help, available in the Help 
menu.

Connecting an External Modem

Your PowerBook provides several different ways to connect to the rest of the world using a 
modem. If your PowerBook came with the optional built-in modem, see “Using Your
PowerBook’s Optional Internal Modem” on page 51. If your PowerBook did not come with 
an internal modem, you can use a PC Card modem in your computer’s PC Card slot (see 
“Using a PC Card Modem” on page 46). You can also connect an external modem to the 
printer/external modem port on the back panel of the computer.

To connect an external modem, follow these steps: 

1 Connect the modem to a power source and to the phone line.

2 Make sure the modem is turned off.

3 With the computer shut down, connect the modem cable to the printer/external modem 
port (´).

4 Turn on the modem.

5 Start up the computer.

The external modem is ready to use.

´ Printer/External
               modem port
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Connecting SCSI Devices

You can attach up to seven SCSI devices, including hard disk drives, CD-ROM drives, and 
scanners, to your computer by linking them together in a chain that starts at your computer’s
SCSI port.

To connect a SCSI device to your Macintosh PowerBook, you need an Apple HDI-30 SCSI
System Cable or equivalent. This cable is light gray, is about 19 inches long, and has 29 pins 
(one “missing” pin) on the end that connects to the PowerBook.

Refer to the manuals that came with your SCSI devices for instructions on installing any 
necessary software, setting SCSI ID numbers, and connecting SCSI cables and SCSI
terminators. The illustrations on the next page briefly describe the proper positioning of 
SCSI terminators. A SCSI chain of devices must include a terminator on the first and last 
devices in the chain (but nowhere else in the chain). Some devices include internal
terminators. Your Macintosh PowerBook is internally terminated.

The names and the part numbers of the cables mentioned in this chapter are as follows: 

Where to add cable terminators when connecting a single SCSI device

Type of Connection Name of Part Part Number

From your computer to a SCSI device Apple HDI-30 SCSI System 
Cable

M2538**/A

From SCSI device to SCSI device Apple SCSI Peripheral
Interface Cable

M0207

For SCSI disk mode Apple HDI-30 SCSI Disk 
Adapter Cable

M2539**/A

Warning  When connecting SCSI equipment, always turn off power to all devices in the 
chain, including your computer. If you don’t, you could lose information and damage your 
equipment.

Terminator
(If this SCSI device has an internal
terminator, omit this external terminator.)

HDI-30 SCSI system cable
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Where to add cable terminators when connecting two or more SCSI devices

Using Your Macintosh PowerBook as a Hard Disk

The Apple HDI-30 SCSI Disk Adapter lets you connect your Macintosh PowerBook to another 
computer as a hard disk. The PowerBook internal drive appears on the desktop of the other 
computer as a hard disk icon, and you can transfer information between the computers by 
dragging files. This feature is called SCSI disk mode.

The Apple HDI-30 SCSI Disk Adapter cable is dark gray, is about 10 inches long, and has 30 
pins.

Connecting Your Computer as a Hard Disk

Before making any connections, you need to assign a unique SCSI ID number to the 
PowerBook. (The ID numbers allow the computer to communicate with several connected 
SCSI devices.)

1 Set up your system software to use your PowerBook in SCSI disk mode.

For information and instructions, see the online help, available in the Help menu. 

If you are connecting the PowerBook to an existing SCSI chain, make sure to give it an ID 
number different from those of the other devices. (Many devices include an ID number 
indicator on the back panel.)

2 Shut down the PowerBook and plug in the power adapter.

SCSI peripheral interface cablesHDI-30 SCSI
system cable

Terminator
(If this SCSI device has an
internal terminator, omit
this external terminator.)

Important  Your Macintosh PowerBook hard disk uses Mac OS Extended format (also 
known as HFS Plus). In order to use your PowerBook in SCSI disk mode, the computer you 
are connecting to must be using Mac OS 8.1 or later. If the computer is using an earlier 
version of system software, you will not be able to see the files on your PowerBook hard 
disk.

Important  Turn off password protection before using SCSI disk mode. For instructions,
see the online help, available in the Help menu.
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3 Shut down the computer you are connecting to and turn off any other devices in the SCSI
chain.

4 Connect the small end of the Apple HDI-30 SCSI Disk Adapter to the SCSI port on your 
PowerBook.

5 If you are connecting the Macintosh PowerBook directly to the other computer (rather than 
to an external device in the SCSI chain), attach a SCSI system cable to the other computer.

6 Connect the large end of the Apple HDI-30 SCSI Disk Adapter cable to a SCSI peripheral 
interface cable attached to the SCSI port on the last device in the SCSI chain, or to the SCSI
system cable on the other computer.

7 Make sure that your PowerBook display is open.

8 Turn on the PowerBook by pressing the Power button (®). After a few seconds a SCSI icon 
appears on the screen, showing the ID number you assigned in step 1.

9 Turn on the other SCSI devices in the chain, if any.

10 Turn on the other computer.

Warning  Always shut down the PowerBook before connecting or disconnecting the 
SCSI disk adapter cable. Connecting the adapter cable while the computer is turned on 
can damage the computer.

Warning  Always keep your PowerBook display open while operating in SCSI disk mode 
because heat from the PowerBook is partially dissipated through the keyboard. Closing 
your display may cause the PowerBook to function improperly.

Warning  If you do not see the SCSI icon, and the computer starts up normally or 
displays an error message, press the Power button (®) to shut down (if you can) and 
then immediately disconnect your computer from the SCSI chain. (If you can’t choose 
Shut Down, try resetting your PowerBook by holding down the Shift, Function ( fn), and 
Control (ctrl) keys and then pressing the Power button. If you cannot shut down your 
PowerBook, you should disconnect the cable anyway, or you may lose information.) Then 
go back and repeat steps 4 through 8, making sure to use the proper cables.
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The PowerBook’s internal drive appears as a hard disk icon on the screen of the computer 
you connected it to. You can now transfer and use files as if the Macintosh PowerBook were 
an external disk drive.

Quitting SCSI Disk Mode

1 Shut down the computer your PowerBook is connected to.

2 Press the Power button (®) on the PowerBook.

3 Turn off any other SCSI devices in the chain.

4 Disconnect the PowerBook from the adapter cable.

5 If necessary, disconnect the adapter cable from the other computer or its SCSI chain.

You can leave the adapter cable attached if you wish.

Your equipment is now ready for normal use. If you disconnected the adapter cable from the 
other computer or SCSI chain, make sure that the SCSI chain is properly terminated.

Important  Do not leave the adapter cable attached to the PowerBook. If you do, the 
computer will behave as though it is still in SCSI disk mode when you try to restart.



Connecting Additional Equipment 63

Using an External Monitor

You can connect an external monitor to your Macintosh PowerBook. The types of monitors 
you can use with this model and the way images are displayed on an external monitor differ 
somewhat from the features available with other PowerBook computers.

To make the best choice of an external monitor, keep the following in mind: 

m Your PowerBook can support a variety of external monitors, including 17-inch and 20-inch 
multiple-scan displays. 

m Your PowerBook display must be open when you use an external monitor because heat 
from the PowerBook is partially dissipated through the keyboard. Closing the display will 
cause the PowerBook to go to sleep. Macintosh PowerBook G3 Series computers do not 
work with the display closed.

m The computer’s back panel has a VGA-style connector. You can connect the cable for a 
VGA-style monitor directly to your PowerBook.

m To connect an Apple-compatible monitor to your PowerBook, you must use the video 
adapter that came with the computer.

m Images can appear on the internal display, the external monitor, or both, depending on 
your choice of resolution on the external monitor.

m When an image appears on both screens, it is exactly the same (this feature is known as 
“simulscan” or “video mirroring”). You cannot move the pointer or menu bar from one 
screen to the other (as you can when a second display is connected to most Macintosh 
desktop computers).

m When an external monitor offers the same resolution as the PowerBook’s internal display,
the image appears on both screens the first time you turn on the computer.

m If a multiple-resolution external monitor provides a list of its capabilities, the list appears 
in the Control Strip. Otherwise the system uses a resolution of 640 x 480 pixels as the 
default for that monitor.

For more information on adjusting the resolution of an external monitor, see the online 
help, available in the Help menu.

Important  Video mirroring works only with the PowerBook display’s standard resolution.
For example, when the 12.1" display is set to its standard resolution (800 x 600) or the 
14.1" display is set to its standard resolution (1024 x 768), the display can mirror the 
external monitor. However, if you switch the resolution to 640 x 480, the built-in display 
will go dark because scaled resolutions cannot be used for video mirroring.
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Connecting an External Monitor

To connect an external monitor to your PowerBook, follow these steps. Also consult the 
documentation that came with the monitor.

1 Press the Power button (®) once to get the Shut Down dialog box.

2 Click Shut Down or Sleep.

If you connect a monitor with your computer turned on, the computer will not recognize the 
monitor.

3 Place the monitor near the PowerBook.

Arrange the monitor so the top of the screen is slightly below eye level while you work. 
Position the monitor to minimize glare and reflections on the screen from lights and 
windows.

4 Make sure that the PowerBook display is open.

5 Make sure the monitor’s power cord is attached to the monitor. Plug the other end into a 
grounded outlet or power strip.

If your monitor’s power cord is designed to plug into the power receptacle on the back of a 
computer, you can obtain a cord with the correct plug from your Apple-authorized dealer.

If you are using a power strip, make sure it is turned on.

6 If you are connecting an Apple-compatible monitor, attach the monitor adapter (shown on 
the next page) that came with your computer to one end of the external monitor’s cable.

If you are connecting a VGA or SVGA monitor, skip this step.

Important  Keep the computer and the monitor at least 8 inches apart. Interference
between the monitor and your computer’s floppy disk drive can cause errors on your 
floppy disks.

8 inches minimum

Important  Macintosh PowerBook G3 Series computers do not support operation with the 
display closed.
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7 Make sure the other end of the monitor’s cable is attached to the monitor. Then attach the 
end of the cable (with the monitor adapter, if you connected it) to the external monitor port 
(™) on the back of the PowerBook.

If you are connecting a VGA or SVGA monitor, do not use the adapter. Connect the monitor 
cable directly to the external monitor port on the PowerBook.

8 Turn on the external monitor.

9 Press the Power button (®) to turn on or wake your computer.

The external monitor is automatically activated. 

10 Click the Resolution icon in the Control Strip and select a resolution from the menu that 
appears.

If you select an external monitor resolution that matches the standard built-in resolution of 
your PowerBook display, the same image will appear on both the display and the external
monitor (known as “simulscan” or “video mirroring”). If you choose a different resolution, 
the PowerBook display will go dark and images will appear only on the external monitor. For
more information on the external monitor resolutions supported by your PowerBook, see 
the Technical Information booklet that came with your computer.

™ External monitor port

Monitor adapter

Monitor cable
(to Macintosh-compatible monitor)
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Resolution icon

Important  Video mirroring works only with the PowerBook display’s standard resolution. 
For example, when the 12.1" display is set to its standard resolution (800 x 600) or the 14.1" 
display is set to its standard resolution (1024 x 768), the display can mirror the external
monitor. However, if you switch the resolution to 640 x 480, the built-in display will go dark 
because scaled resolutions cannot be used for video mirroring.
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Trouble With the External Monitor?

m Nothing happened when you tried to turn on or wake the PowerBook.

Make sure that all your equipment is connected properly. Then try turning on or waking 
the computer again.

Make sure that the battery is charged, or that the power adapter is plugged into both the 
computer and an electrical outlet. If you are using a power strip, make sure it is turned
on.

m The computer is on, but the external monitor is dark.

Make sure that the monitor’s power cord is connected and that its power switch is on. Try
adjusting the monitor’s brightness and contrast settings. If this doesn’t work, try
restarting your computer.

Note: The screen-dimming feature in the Energy Saver control panel turns the screen 
brightness down to a low level when you haven’t used the computer for a few minutes. 
( You can think of dimming as display sleep.) Dimming also affects the external monitor.
When you move your finger on the trackpad or press a key on the keyboard, the 
brightness is restored on both screens. For information and instructions on setting screen 
dimming, see the online help, available in the Help menu.

m The PowerBook goes to sleep when you close the display.

The PowerBook display must be open when using an external monitor.

Disconnecting an External Monitor

1 Make sure your computer is shut down or in sleep.

2 Make sure your monitor is switched off.

3 Disconnect the monitor cable (for a VGA-style monitor) or monitor adapter (for an Apple 
monitor) from the external monitor port on the computer’s back panel. 
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Using an External Video Display or Recording Device

Your PowerBook has an S-video output port (labeled with the Æ icon) where you can 
connect an external video display or recording device such as a television, videocassette 
recorder ( VCR), or video projection system. 

Note: Due to the display limitations of most televisions, images displayed on the television 
screen will be of lower quality than images on the built-in display or an external monitor. For
best results, always use an S-video connection when available. 

Using the S-video output port, you can display your PowerBook desktop on a television 
screen and record images from the desktop to a VCR.

PowerBook computers equipped with an S-video output port can output the following 
display formats:

m S-video:  High-quality video format used by certain televisions, VCRs, and video 
projectors. You can connect a cable from an S-video device directly to the S-video output 
port (Æ) on the back panel of your PowerBook. S-video is recommended because it 
provides better quality.

m Composite video: Video format used by most televisions and VCRs. To connect a 
composite video device, you need to use the composite to S-video adapter that came with 
your PowerBook.

Æ S-video output port
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Warning  The S-video output port (labeled with the Æ icon) looks similar to the ADB 
port (labeled with the V icon) and the printer/modem port (labeled with the ´ icon). 
Only plug your S-video device into the S-video output port. Plugging a video device into 
the wrong port could damage your equipment.

S-video plugRCA plug

Composite to S-video adapter
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Connecting Video Equipment to Your PowerBook

You can record and deliver a sophisticated presentation by combining the video and sound 
capabilities of your PowerBook. The steps that follow explain how to set up equipment for 
displaying the computer desktop on a television and recording the computer’s output to 
videotape. Use the information in this section as a guideline when connecting other external
video display and recording devices.

Note: You cannot use the S-video output port and the external monitor port at the same 
time.

To connect a television or VCR for output from the computer: 

1 Shut down your PowerBook and turn off the television or VCR.

2 Attach one end of a video cable (not included with your PowerBook) to the video in port on 
the television or VCR. Follow the directions that came with the television or VCR.

3 If you’re using an RCA-type cable, plug in the other end of the video cable to the composite 
to S-video adapter. If you’re using a device that supports S-video, skip this step.

4 Plug the S-video cable or adapter to the S-video output port (Æ) on the back panel of your 
PowerBook.

PowerBook connected to a television using an S-video cable

S-video cable (not included with your computer)

RCA-type cable (not included with your computer)

Important  If the connector doesn’t slide easily into the port, check the pin alignment and 
try again. Don’t use force, which could damage your equipment.

TV

S-video
       output port
Æ

S-video cable

S-video In port
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PowerBook connected to a television using an RCA-type cable

5 If you want to output sound as well as video from your PowerBook, use a 
dual-RCA-plug–to–stereo-miniplug cable (not included with your computer) to connect the 
sound output port on the back of your PowerBook to audio input ports on your television or 
VCR.

6 Turn on the computer and the television or VCR.

Your PowerBook starts up using the built-in display. The television is dark.

7 Click the Resolution icon in the Control Strip and select a NTSC or PAL compatible screen 
resolution from the menu that appears. For best results use 640 x 480, 60 Hz for NTSC
systems and 640 x 480, 50 Hz for PAL systems. 

The PowerBook display becomes dark and images appear on the television. 

8 To switch back to your PowerBook display, select the “built-in” resolution for your 
PowerBook from the Control Strip. 

TV

RCA In port
S-video

       output port
Æ

Composite to S-video adapter RCA-type cable

Dual-RCA-plug–to–stereo-miniplug cable
(not included with your computer)

Resolution icon
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Trouble With the External Video Device?

m Nothing happens when you tried to turn on the PowerBook.

Make sure your equipment is connected properly. Then try pressing the Power button 
(®) again.

Make sure the battery is charged, or the power adapter is plugged into both the computer 
and an electrical outlet. If you are using a power strip, make sure it is turned on.

m The computer is on, but the television is dark.

Select an NTSC or PAL compatible resolution from the Resolution icon in the Control 
Strip. If the television is still dark, make sure that the television is on and set up to receive 
video from an outside source. See the manual that came with your television or other 
video device for more information. If this doesn’t work, try restarting your computer.

Note: The screen-dimming feature in the Energy Saver control panel turns the screen 
brightness down to a low level when you haven’t used the computer for a few minutes. 
Dimming also affects the television. When you move your finger on the trackpad or press 
a key on the keyboard, the brightness is restored on both screens. For information on 
screen dimming, see the online help, available in the Help menu.

Disconnecting an External Video Device

1 Make sure your computer is shut down or in sleep.

2 Make sure your television or other external video device is switched off.

3 Disconnect the S-video cable or S-video adapter from the S-video output port (Æ) on the 
computer’s back panel. 
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Connecting and Using Sound Input Devices

Your computer has a built-in microphone. In addition, you can connect a PlainTalk
microphone to the external sound input port (√). ( You can also connect a standard line-
level input microphone, although it is not suitable for speech recognition.) You can find
more information on using the microphone to record sounds in the online help, available in 
the Help menu.

Note:  When using an external microphone, set the volume to 50 percent and point the 
microphone away from the PowerBook speakers. Pointing the microphone towards the 
speakers with the volume set to maximum may result in feedback.

Because your PowerBook can receive sounds from a variety of different sources, such as the 
internal microphone, expansion bay module, or zoomed video card, you need to select a 
sound input source.

m Click the Sound Source icon in the Control Strip and choose an input source from the 
menu that appears.

- Sound output port

√ Sound input port

-
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Sound Source icon
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Connecting Sound Output Devices

The Macintosh PowerBook has a stereo sound output port (-) to which you can connect 
externally powered speakers, an amplifier, headphones, or other audio output device. The 
sound output port accepts a standard stereo miniplug, like that used to attach headphones 
to a portable tape or CD player.

Your computer also has two stereo speakers, which play sound from the following sources: 
audio CD in the CD-ROM or DVD-ROM drive, external stereo device connected to the 
computer through the sound input port, zoomed video card, internal modem, or file on your 
hard disk.

The computer automatically selects the sound output source. If an external device, such as a 
pair of headphones, is connected, sound is routed there. If no external output device is 
connected, sound plays through the computer’s speakers.

Locking Your Computer 

You can purchase a security cable and lock to protect your Macintosh PowerBook. With a 
lock, you can secure your computer to a desk or table. See your Apple-authorized dealer or 
computer retailer for details on security devices.

Note: You can protect the contents of your hard disk by turning on password protection. 
You can find more information on password security in the online help, available in the Help 
menu.

Important  A security locking cable does not prevent the removal of expansion bay 
modules or batteries or access to your RAM and hard disk.

Sample locking device
with security cable

Ç Security slot
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Connecting a Mouse, Keyboard, or Other ADB Device

You can connect a mouse, keyboard, graphics tablet, or other Apple Desktop Bus (ADB) 
device to the ADB port on the back panel of the PowerBook.

Note: You may experience a slight delay if you connect a mouse or other ADB device while 
the computer is turned on.

Connecting Other Devices

For instructions on connecting a device not discussed in this chapter, refer to the 
documentation that came with the device.

V Apple Desktop Bus (ADB) port
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4
4 Installing a RAM Expansion Card 

and Removing Your Hard Disk
This chapter provides information about installing a RAM expansion card and removing your 
PowerBook hard disk for service or security reasons.

Getting Ready

Before you open your computer, you need to make sure that you have a Phillips or a Torx T-8 
screwdriver (available from a hardware or electronics supply store). 

Removing the Keyboard and Internal Heat Sink

The design of your Macintosh PowerBook allows you to easily access the internal
components of the computer by removing the keyboard. The steps in this section explain 
how to remove the PowerBook keyboard and internal heat sink to access the RAM expansion 
slot and internal hard disk.

1 Place your PowerBook on a hard, flat surface.

Warning  To avoid damage to your computer, Apple recommends that only an Apple-
certified technician install additional RAM. Consult the service and support information
that came with your Apple product for instructions on how to contact an Apple-
authorized service provider or Apple for service. If you attempt to install additional RAM 
yourself, any damage you may cause to your equipment will not be covered by the limited 
warranty on your computer. See an Apple-authorized dealer or service provider for 
additional information about this or any other warranty question.
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2 If your PowerBook is turned on, press the Power button (®). In the Shut Down dialog box, 
click Shut Down.

3 Unplug the power adapter and any other devices from the back of your PowerBook. Unplug 
any phone line from the internal modem. 

4 Adjust your display so that it is at a 90-degree angle to the computer.

If your display is tilted too far back, your PowerBook may tip backward when the expansion 
bay modules are removed in the next step.

5 Pull out both expansion bay release levers to eject the modules or batteries in both the 
expansion bays.

6 Remove the modules or batteries from both the expansion bays.

Warning  The internal components (including the internal heat sink) of your PowerBook
may be hot. If you have been using your PowerBook, wait 10 minutes before continuing, 
to let the internal components cool down.

90o



Installing a RAM Expansion Card and Removing Your Hard Disk 77

7 With your thumbs positioned slightly below the keyboard, place your fingers inside the 
expansion bays and locate the small plastic tabs that hold the keyboard in place. 

The plastic tabs have small ridges on them and are located on the underside of the top shell 
of the PowerBook approximately one inch inside each expansion bay.

8 Gently slide the plastic tabs toward you until you see the lower portion of the keyboard pop 
up.

9 Lift the lower portion of the PowerBook keyboard up slightly and pull it back enough to 
displace the five metal tabs that hold the front of the keyboard in place.

Plastic tab

Plastic tab

Tabs
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10 Flip the keyboard over and lay it on the palm rests and trackpad.

11 Remove the two screws that secure the internal heat sink (using a Phillips or Torx T-8 
screwdriver) and then lift it up by pulling on the small metal tab. 

You now have access to the internal components of your PowerBook.

Warning  The PowerBook internal heat sink may be hot. If you have been using your 
PowerBook, wait 10 minutes before continuing to let the internal components cool down.

Screws

Small metal tabHeat sink
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Installing a RAM Expansion Card

To install a RAM expansion card in your PowerBook, follow these steps: 

1 If you have not already done so, remove the PowerBook keyboard and internal heat sink as 
described in “Removing the Keyboard and Internal Heat Sink” on page 75.

2 Locate the empty RAM expansion slot. 

Note: If you ordered your PowerBook with additional memory, this slot may already have a 
RAM card installed. 

3 Gently touch the metal surface on the right side of the inside of the computer to discharge
any static electricity built up on your body.

This prevents damage to your Macintosh PowerBook or RAM card.

Don’t walk around while installing the card. If you do, touch the metal surface again to 
discharge any static electricity.

Important  Make sure that the RAM expansion card you are installing is made for your 
Macintosh PowerBook model. Components designed for other PowerBook models will not 
work with your computer.

RAM expansion slot

Metal portion
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4 Position the RAM expansion card at a 30-degree angle. Line up the notch in the PowerBook
RAM expansion card with the small tab in the RAM expansion slot.

5 Push the RAM expansion card into the plastic expansion slot. 

You may feel some resistance. If you are having trouble inserting the card, try pushing one 
side at a time.

6 Gently push the RAM expansion card down until the two snaps on either side of the card 
lock into place. 

Your RAM expansion card is now ready to use.

7 Skip ahead to “Replacing the Keyboard and Internal Heat Sink” on page 83.

30o

Snap
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Removing Your PowerBook Hard Disk Drive

Your PowerBook was designed so that you could easily remove your internal hard disk drive 
for service or security needs.

1 If you have not already done so, remove the PowerBook keyboard and internal heat sink as 
described in “Removing the Keyboard and Internal Heat Sink” on page 75.

2 Locate the hard disk drive. 

3 Gently touch the metal surface on the left side of the inside of the computer to discharge any 
static electricity built up on your body.

This prevents damage to the Macintosh PowerBook or internal hard disk drive.

Don’t walk around while removing the hard disk drive. If you do, make sure you touch the 
metal surface again to discharge any static electricity.

Hard disk drive

Metal portion of
processor cage
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4 Loosen the screw that locks the hard disk in place.

Note: The hard disk screw stays attached to the hard disk; you do not need to remove it 
completely.

5 Gently pull up on the small metal tab (located on the left side of the hard disk) to disengage 
the hard disk from the logic board.

6 Carefully lift the hard disk out of the PowerBook.

Always store your internal hard disk in a safe place and avoid contact with the hard disk 
connectors.

Hard disk screw
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Replacing the Keyboard and Internal Heat Sink

Follow the steps in this section to replace your PowerBook keyboard.

1 Insert the internal heat sink and replace the two screws to secure it in place.

2 Press down on the bottom portion of the heat sink to secure it into place.

3 Flip the keyboard back on top of the opening in your PowerBook.

4 Insert the five small tabs at the top of the keyboard into the opening in the PowerBook case.

5 Press down on the lower portion of the keyboard until it snaps into place.

6 Replace the expansion bay modules.

Screws

Tabs
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You are now ready to start working with your PowerBook again.

Warning  Never turn on your PowerBook G3 Series computer unless all of its internal
and external parts are in place. Operating the computer when it is open or missing parts 
can be dangerous, and can damage your computer.
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Health, Safety, and Maintenance Tips

Health-Related Information About Computer Use

Muscle soreness, eye fatigue, and other discomforts and injuries sometimes associated with 
using computers can occur from performing any number of activities. In fact, misuse of the 
same muscles during multiple activities can create a problem that might not otherwise exist. 
For example, if you engage in nonwork activities that involve repetitive stress on the wrist—
such as bicycling—and also use your computer’s keyboard improperly, you may increase your 
likelihood of developing wrist problems. Some individuals are at greater risk of developing 
these problems because of their health, physiology, lifestyle, and general exposure to stress. 
Work organization and conditions, such as workstation setup and lighting, also play a part in 
your overall health and comfort. Preventing health problems is a multifaceted task that 
requires careful attention to the way you use your body every hour of every day.

The most common health effects associated with using a computer are musculoskeletal
discomfort and eye fatigue. We’ll discuss each area of concern in this appendix.

Musculoskeletal Discomfort

As with any activity that involves sitting for long periods of time, using a computer can make
your muscles sore and stiff. To minimize these effects, set up your work environment 
carefully, using the guidelines that follow, and take frequent breaks to rest tired muscles. To
make working with your computer more comfortable, allow enough space in your work area 
so that you can change position frequently and maintain a relaxed posture.

Another type of musculoskeletal concern is repetitive stress injuries (RSIs), also known as 
cumulative trauma disorders (CTDs). These problems can occur when a certain muscle or 
tendon is repeatedly overused and forced into an unnatural position. The exact causes of 
RSIs are not totally understood, but in addition to awkward posture, such factors as the 
amount of repetition, the force used in the activity, the individual’s physiology, workplace 
stress level, and lifestyle may affect the likelihood of experiencing an RSI.
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RSIs did not suddenly arise when computers were invented; tennis elbow and writer’s cramp, 
for example, are two RSIs that have been with us for a long time. Although less common than 
other RSIs, one serious RSI discussed more often today is a wrist problem called carpal 
tunnel syndrome, which may be aggravated by improper use of computer keyboards. This 
nerve disorder results from excessive pressure on the median nerve as it passes through the 
wrist to the hand.

This section offers advice on setting up your work area to enhance your comfort while you 
use your computer. Since the effects of repetitive movements associated with using a 
computer can be compounded by those of other work and leisure activities to produce or 
aggravate physical problems, proper use of your computer system must be considered as just 
one element of a healthy lifestyle.

No one, of course, can guarantee that you won’t have problems even when you follow the 
most expert advice on using computer equipment. You should always check with a qualified
health specialist if muscle, joint, or eye problems occur.

Eye Fatigue

Eye fatigue can occur whenever the eyes are focused on a nearby object for a long time. This 
problem occurs because the eye muscles must work harder to view an object that’s closer 
than about 20 feet (6 meters). Improper lighting can hasten the development of eye fatigue. 
Although eye fatigue is annoying, there’s no evidence that it leads to permanent damage.

Whenever you’re engaged in an activity that involves close-up work—such as reading a 
magazine, doing craft work, or using a computer—be sure to have sufficient glare-free 
lighting and give your eyes frequent rest breaks by looking up and focusing on distant 
objects. Remember to have your eyes examined regularly.

To prevent discomfort and eye fatigue: 

m Arrange your work space so that the furniture is properly adjusted for you and doesn’t
contribute to an awkward working posture.

m Take frequent short breaks to give your muscles and eyes a chance to rest.
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Arranging Your Work Area and Equipment

The suggestions in this section can help you work more comfortably with you computer.

Chair

m An adjustable chair that provides firm, comfortable support is best. Adjust the height of 
the chair so your thighs are horizontal and your feet flat on the floor.

The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to fit your body properly.

Keyboard and Trackpad

m When you use the keyboard and trackpad, your shoulders should be relaxed. Your upper 
arm and forearm should form an approximate right angle, with your wrist and hand in 
roughly a straight line. 

m You may have to raise your chair so your forearms and hands are at the proper angle to 
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a 
footrest with adjustable height and tilt to make up for any gap between the floor and your 
feet. Or you may lower the desktop to eliminate the need for a footrest. Another option is 
to use a desk with a keyboard tray that’s lower than the regular work surface.

m Use a light touch when typing or using the trackpad and keep your hands and fingers
relaxed. Avoid rolling your thumbs under your palms.

Some computer users may develop discomfort in their hands, wrists, or arms after intensive 
work without breaks. If you begin to develop chronic pain or discomfort in your hands, 
wrists, or arms, consult a qualified health specialist.

m Change hand positions often to avoid fatigue.

Not thisThis

This Not this
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Mouse

If you use an external mouse, position the mouse at the same height as your keyboard. Allow 
adequate space to use the mouse comfortably.

Built-In Display

m Adjust the angle of the display to minimize glare and reflections from overhead lights and 
windows.

m You may need to adjust the brightness and contrast of the screen when you take the 
computer from one work location to another, or if the lighting in your work area changes.

External Monitor

If you use an external monitor, this suggestion may be helpful.

m If possible, arrange the monitor so the top of the screen is slightly below your eye level 
when you’re sitting at the keyboard. The best distance from your eyes to the screen is up 
to you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).

Avoiding Fatigue

m Change your seated position, stand up, or stretch whenever you start to feel tired. 
Frequent short breaks are helpful in reducing fatigue.

m Allow adequate work space so that you can work comfortably. Place papers or other items 
so you can view them easily while using your computer. A document stand may make
reading papers more comfortable.

m Eye muscles must work harder to focus on nearby objects. Occasionally focus your eyes 
on a distant object, and blink often while you work. 

m Clean your screen regularly. Keeping the screen clean helps reduce unwanted reflections.

What About Electromagnetic Emissions?

There has been recent public discussion of the possible health effects of prolonged exposure 
to extremely low frequency (ELF) and very low frequency (VLF) electromagnetic fields. Such 
fields are associated with electromagnetic sources such as television sets, electrical wiring, 
and some household appliances—as well as computer monitors.

Apple has reviewed scientific reports and sought the counsel of government regulatory
agencies and respected health organizations. Based on the prevailing evidence and opinions, 
Apple believes that the electric and magnetic fields produced by computer monitors do not 
pose a health risk. In response to those customers who wish to reduce their exposure to 
electromagnetic fields, Apple has lowered the emission levels of its products. 
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Important Care and Safety Instructions

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug (by pulling the plug, not the cord) and remove the expansion bay 
battery if any of the following conditions exists:

m you want to remove any parts (leave the cord disconnected as long as the keyboard is 
open)

m the power cord or plug becomes frayed or otherwise damaged

m you spill something into the case

m your PowerBook G3 Series computer is exposed to rain or any other excess moisture

m your PowerBook G3 Series computer has been dropped or the case has been otherwise
damaged

m you suspect that your PowerBook G3 Series computer needs service or repair

m you want to clean the case (use only the recommended procedure described later)

Important  The only way to disconnect power completely is to unplug the power cord and 
remove the batteries. Make sure at least one end of the power cord is within easy reach so 
that you can unplug the PowerBook G3 Series computer when you need to.

Be sure that you always do the following:

m Keep your PowerBook G3 Series computer away from sources of liquids, such as 
washbasins, bathtubs, shower stalls, and so on.

m Protect your PowerBook G3 Series computer from dampness or wet weather, such as rain, 
snow, and so on.

m Read all the installation instructions carefully before you plug your PowerBook G3 Series 
computer into a wall socket.

m Keep these instructions handy for reference by you and others.

m Follow all instructions and warnings dealing with your system.

To clean the case, do the following:

1 Disconnect the power plug. (Pull the plug, not the cord.)

2 Wipe the surfaces lightly with a clean, soft cloth dampened with water. Clean the screen with 
soft, lint-free paper.

Warning  Electrical equipment may be hazardous if misused. Operation of this product, 
or similar products, must always be supervised by an adult. Do not allow children access 
to the interior of any electrical product and do not permit them to handle any cables.
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Caution

m If you have a problem with your computer and nothing in the computer manual solves 
the problem, take the computer to your Apple-authorized dealer or service provider.
Attempting to repair the computer yourself may void the limited warranty.

m Do not move the computer when you can hear its hard disk spinning. When you put the 
computer to sleep, wait until the screen is blank before moving the computer.

m Never force a connector into a port. Make sure that the connector matches the port and 
that it’s right side up. If the connector and port do not join easily, they do not match.

m Do not use the computer in wet or dusty environments.

m Keep dirt and liquids away from the ports on the back panel, the keyboard, and the 
trackpad. If you spill any food or liquid onto the computer, shut it down immediately,
unplug it, and remove the expansion bay modules before cleaning up the spill. 
Depending on what you spilled and how much got into the computer, you may have to 
bring the computer to an Apple-authorized service provider for cleaning.

m Do not touch the screen with any sharp or pointed objects.

m Use only the battery supplied with your computer, or an identical model. Batteries 
designed for other portable computers may look similar, but they may not work with your 
computer and may damage it.

m Use only the power adapter supplied with your computer, or an identical model. Adapters 
designed for other electronic devices may not work with your equipment and may 
damage it.

m When using your PowerBook or when charging the battery, it is normal for the bottom of 
the case to get warm. The bottom of the PowerBook case functions as a cooling surface
that transfers heat from inside the computer to the cooler air outside. The bottom of the 
case is raised slightly to allow airflow that keeps the unit within normal operating 
temperatures.

Important

m Use the computer only in environments where the temperature range is between 
50°F/10°C and 95°F/35°C.

m Do not expose the computer to very low (less than –13°F/–25°C) or very high (more 
than 140°F/60°C) temperatures.

m If the computer has been in a cold place for several hours, let it warm up to room 
temperature before you use it.
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Caring for Batteries
m Always handle batteries carefully.

m Do not short-circuit the battery terminals (that is, do not touch both terminals with a 
metal object). Do not carry loose batteries in a pocket or purse where they may mix with 
coins, keys, or other metal objects. Doing so may cause an explosion or a fire.

m Do not drop, puncture, disassemble, mutilate, or incinerate the battery.

m Recharge batteries only as described in this manual and only in ventilated areas. 

m Do not leave batteries in hot locations (such as the trunk of a car) for more than a day or 
two. Intense heat can shorten battery life. 

m Do not leave a battery in storage for longer than 6 months without recharging it.

Handling Floppy Disks

125° F (52° C)

50° F (10° C)

Do not use a
pencil or an 
eraser on a disk
or disk label.

Store disks at
temperatures
between 50° F
and 125° F.

Do not touch the
exposed part of the
disk behind the 
metal shutter.

Keep disks away 
from magnets.
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Handling CD and DVD Discs

Traveling With the Macintosh PowerBook

Always bring the system software CD that came with your computer when you travel. If you 
experience system software problems while traveling, you may need it to correct any 
problems.

Take the necessary plug adapters if you’re traveling overseas. (You may need to use them 
with the power cord.) You do not need a voltage transformer. The power adapter can handle 
100 volts to 240 volts AC (50 Hz to 60 Hz).

Check the following diagrams to determine which plug adapters you’ll need, or ask your 
travel agent.

Do not put tape
on discs.

Do not scratch
discs.

Do not write
on discs.

Do not spill liquids
on discs.

Do not get
dust on discs.

Do not expose discs
to direct sunlight.

Outlet Type Locations

United States, Canada, parts of Latin America, Japan, 
Korea, the Philippines, Taiwan

Russia and the Commonwealth of Independent States 
(CIS), most of Europe, parts of Latin America, the Middle 
East, parts of Africa, Hong Kong, India, most of South Asia

Mexico, United Kingdom, Ireland, Malaysia, Singapore, 
parts of Africa 

China, Australia, New Zealand
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Airplanes and Airports

Some airlines have reported that use of portable electronic devices may have interfered with 
the aircraft’s flight navigation or communications systems. Many airlines restrict or manage 
the use of electronic equipment during flights. Please respect the regulations of the airlines.

A properly tuned X-ray machine or metal detector should cause no damage to your 
Macintosh PowerBook. But the motors that drive the belts on some security machines have 
magnets that can damage your information. To avoid problems, place the Macintosh 
PowerBook close to the entrance of the machine and remove it as soon as possible. At most 
airports you can also have the computer hand-inspected by security personnel.

Security officials may require you to turn the Macintosh PowerBook on. Make sure you have 
a charged battery on hand. To speed up the security process, have your PowerBook in sleep 
instead of shut down. 

Handling Your Macintosh PowerBook

The safety instructions earlier in this appendix also apply when you are traveling. In addition, 
note these precautions: 

m Do not transport your Macintosh PowerBook while it is turned on. Put your computer to 
sleep or shut it down before you move it.

m Do not check your computer as baggage. Carry it with you.

International Repair and Service

Apple’s limited warranty covers your Macintosh PowerBook for one year, regardless of where 
it is purchased. The Apple-authorized service providers in more than 80 countries can handle 
most repairs (unless the repair involves a component specific to another area of the world). 
Bring a copy of your proof of purchase with you.

Storing the Macintosh PowerBook

1 Save your work on a hard disk or floppy disks.

2 Press the Power button and click Shut Down, or choose Shut Down from the Special menu.

3 Close the display.

4 Store the computer in a cool, dry place.

Storage temperatures should remain between –25°C and 60°C (between –13°F and 140°F). 
Avoid leaving the computer where temperatures may be extreme or unpredictable—in the 
trunk of a car, for example.
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Service and Support

If your computer is malfunctioning but does not appear to be physically damaged, shut it 
down (and leave the power adapter plugged in, if possible) until you can get help.

If you know or suspect that your computer is physically damaged, disconnect the power 
adapter, remove the battery, and do not use the computer until it can be repaired.

Modem and Fax Safety

If you’re planning to install telephone wiring or telephone jacks, follow these precautions: 

m Never install telephone wiring during a lightning storm.

m Never install telephone jacks in wet locations unless the jacks are specifically designed for 
wet locations.

m Never touch uninsulated telephone wires or terminals unless the telephone line has been 
disconnected at the network interface.

m Use caution when installing or modifying telephone lines.

m Avoid using a telephone, other than a cordless type, during an electrical storm. There may 
be a remote risk of shock from lightning. 

m Never use a telephone to report a gas leak while in the vicinity of the leak. 

Important  See the service and support information that came with your computer for 
information about customer assistance.

Important  Disconnect the telephone line from the PowerBook before removing the 
keyboard to access the internal components.


